
XP BASICS & INTERNET WORKSHOP –  Page 1 of 10 
 MAKE A MOVIE WITH MOVIEMAKER VER 2 

XP BASICS – CREATE A MOVIE TO USE WITH POWERPOINT OR JUST EMAIL IT 

Start First By Setting the View. 
  On the menu toolbar select 
View, then and from the drop 
down menu click Task. This 
will set the left side of the 
screen to appear like this.  
Now you can understand the 
steps to create the movie. 
 

 
Build a Storyboard 

Movie Maker automatically divides your video into segments to make it 

easier to drag and drop the parts you want onto the storyboard where 

you put your movie together.  

To build a storyboard: 

1. Import video  or your stills to your PC. You'll see your clips in the 

Collections view.  

2. Double click on each clip to see how it looks in the preview window. 

3. Once you've decided which ones you want to put in your movie, 

click and drag the clips to the Storyboard in the order in which 
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you'd like them to appear in your final movie 

 
The Storyboard  

4. To rearrange your clips on the storyboard, just drag and drop them 

to a different location.  

Edit Your Clips 

Trim your clips to get exactly the footage you need. 

To edit clips: 
1. In the Timeline view, click on the clip you'd like to trim.  

2. In the Preview window, drag the scroll bar slowly and watch as the video 

progresses.  

3. Stop at the point where you want to trim the clip.  

4. On the Clip menu, click Set Start Trim Point.  

5. Now continue to drag the progress indicator until you reach the desired end point 

of your clip. 

 
Editing a clip  

6. On the Clip menu, click Set End Trim Point.  

7. You will now have your trimmed clip. : 

Add Audio 

A soundtrack can really draw your audience in and add fun to your home movies. 

Just import your favorite clips and then drag them to the timeline.  

To add audio: 
1. In the Taskpane, click on Import audio or music.  

2. Navigate to the music track you'd like to add to your movie .  

3. Click on Import.  

4. The music track will appear in your Collection view. 
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A music clip in the Collection view  

5. Click on Show Timeline button in the Storyboard section of your screen. 

6. Drag your music track to the Audio/Music level of the Timeline.  

Adding a soundtrack is a great way to enhance the meaning 
and excitement of the movies you create. With Windows 
Movie Maker 2 for Windows XP, it's easy to add favorite 
songs, evocative mood music, or any other audio you'd like 
to include as part of a soundtrack. 
Once you've assembled the elements of your home movie on 
the storyboard, you're ready to add music. Here's how: 
1. In the Tasks Pane, click Import audio or music (or click on File 

menu, then Import into collections)  
2. Your My Music folder will open. Navigate to the song that you 

want and click on it, then click the Import button in the lower right-
hand corner. This will bring your music clip into your collection.  

3. Click on the Show Timeline button above the storyboard, or use 
the View drop-down menu and click on Timeline  

4. Drag the audio file down to the Audio/Music track  
5. You can move the audio clip left to right to coincide with a 

particular video clip. And if the music is too long for your video, 
you can trim it. Simply scroll along the Timeline all the way to the 
right, so you can see the end of the audio clip. Move the cursor 
onto the end of the song, and a red double arrow will appear. Drag 
the clip to the left as far as you want to create the end point of the 
music.  
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Do It Yourself 
Get creative and have more fun enhancing your movies with 
techniques used by professional video producers. 
Add Transitions 
You can make your movie look more polished and professional by 
using transitions to move between clips. If you want more pizzazz in 
your vacation highlights, a fade or spin from one location to the next 
can really add excitement to your video.  
To add transitions: 
1. Build your Storyboard by dragging clips in the desired order.  
2. In the Edit Movie section of the Taskpane, click View video 

transitions. A selection of transitions will appear. 

 
A selection of transitions  

3. Double-click the transitions to see how they look in the preview 
window.  

4. Once you've decided which transitions to include in your final 
movie, drag them down to the Storyboard and place them in the 
squares between your video clips. 

Add Titles and Credits 
You can insert titles and scrolling credits at the end of your movie, just 
like a professional Hollywood film. 

To add titles and credits: 
1. In the Taskpane, click Make titles or credits.  
2. On the next screen, click the appropriate link that corresponds to 

the place where you want to add the title or credits to your movie.  
3. Enter the text you want to appear in your title or credits.  
4. Click Change the title animation, and then select a title 

animation from the list. You can preview them by clicking on them. 
5. Click Change the text and font color, and then select the font 

you like, as well as the color of the text and background.  
6. You can also alter the transparency, font size, and position of the 

title.  
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7. Click Done, and your title or credit will be added to your 
storyboard. 

 
A title on the storyboard  

 

Add Effects JUST LIKE IN POWERPOINT – BUT MORE CHOICES 
HERE. Dozens of effects right at your fingertips give you more ways to 
enhance your story.  

To add titles and credits: 
1. In the Taskpane, click View video effects. A selection of video 

effects will appear. 

 
Video effects selection  

2. Double-click the effects to see how they look in the preview 
window.  

3. Once you've decided which effects to include in your final movie, 
drag them down to the Storyboard and place it on top of the star 
in the lower left hand corner of the clip 

Save you video to share with friends  

Windows Movie Maker 2 simplifies and automates the process of 
assembling your clips and compressing digital video to create movies 
you can show to friends and family. Here are four easy ways to save 

and share your movies. 

See It in Action 
Watch the video, and then follow the steps below to share your movies 
in a way that works for you—on your 1) computer, 2)  on CD   3), via 
e-mail, or  4)on the Web. Watching the video requires that you have 
Windows Media Player.  Here is that website to DownLoad Media 
Player 

http://www.microsoft.com/windows/windowsmedia/players.aspx 
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Save a movie to your computer 

Saving a movie to the My Computer folder lets you save a high-quality 
version of your home video or work in progress into the convenient My 
Videos folder.  

Option 1: To save a movie to your computer: 

1. Once your movie is assembled, click Save to my computer in the 
Taskpane.  

2. Enter a name for your movie.  
3. Choose a place to save your movie. Your My Videos folder will be 

the default location, but you can store it anywhere you like on your 
hard drive.  

4. Click Next.  
5. Select the setting for your new movie. Windows Movie Maker will 

recommend a setting, but you can choose a different setting if you 
like. Note that the setting details and the Movie file size appear in 
the lower portion of the Wizard. 

 
Choosing a setting  

6. Click Next.  
7. Your movie will be saved.  
8. Click the check-box in the Wizard if you'd like to play your movie 

when you click Finish.  
9. Click Finish. 
Option 3 Save a movie to a CD 

Because Windows XP offers native support for CD burning, movies 
created with Windows Movie Maker 2 can be copied to CDs easily, at 
the full speed of the CD-R or CD-RW drive. This is a great way to share 
high quality playback with friends and family on the computer.  

To save  a  movie  to  CD:  
1. Once your movie is assembled, click Save to CD in the Taskpane. 
2. Enter a name for your movie and a name for your CD. (These can 

be the same, but the CD is limited to 16 characters.)  
3. Click Next.  
4. On the Movie Setting page, do one of the following:  

1. To use the default movie setting, click Best quality for 
recordable CD (recommended). The specific setting details, 
such as the file type, bit rate, display size, aspect ratio, and 
frames per second displayed in the video, are shown in the 
Setting details area. Keep in mind that a CD typically has 
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650 MB of storage space, so you can adjust settings 
accordingly to maximize quality of the final product. 

 
Setting details  

2. To use a different movie setting, click Show more choices, 
and then choose another movie setting from the list.   

5. Click Next. Windows Movie Maker will create your movie.  

6. When finished, your CD will eject from your computer. Click 

Finish. 

Option 3 : Send a movie in e -mail 
The great compression and quality of Windows Media Video means you 
can finally e-mail video of your baby's first steps, your vacation 
highlights, or any memories you want to share.  

To send a movie in e-mail: 
1. Once your movie is assembled, click Send in e-mail in the 

Taskpane.  
2. Windows Movie Maker will save your movie, automatically selecting 

a setting that will keep the file size small enough to be accepted by 
most e-mail systems.  

3. After the movie is saved, you can play your movie or save it to 
your hard drive before sending it in e-mail. If you want to send 
immediately in e-mail, skip to Step 6.  

4. To play the movie in your default player before sending it in e-mail, 
click Play the movie.  

5. To save a local copy of the movie on your computer before sending 
it in e-mail, click Save a copy of my movie on my computer, 
enter a movie file name in the File name box, and then click Save.  

6. Click Next, and your default e-mail program will open with your 
movie included as an attachment. 

 
E-mail with movie attached  

7. Address your e-mail to the appropriate people, add a subject or 
any other personalized message you like, and Send. 
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Option 4 Post a movie to the Web 

Save your movies and then send them to a video hosting provider on 
the Web—if you don't currently have a hosting provider, you can sign 
up directly from the Wizard. This is a great way for family and friends 
to watch edited home movies.  
To post a movie to the Web: 
1. Once your movie is assembled, click Send to the web in the 

Taskpane.  
2. Enter the name of your movie and click Next.  
3. On the Movie Setting page, do one of the following:  

1. Choose one of the movie settings that best matches the 
Internet connection speed of your intended audience. 

 
Selecting a connection speed  

2. Click Show more choices, and select one of the additional 
movie settings.   

4. Click Next and wait for your movie to be saved.  
5. On the Select a Video Hosting Provider and Sign In page, click 

Sign up now to see a list of video hosting providers available, and 
then sign up and establish an account with a provider. Sign in with 
your new user name and password, the come back to Movie Maker 
and enter in your User Name and Password.  

6. If you already have an account with a video hosting provider, 
simply enter in your User Name and Password.  

7. Click Next, and Windows Movie Maker will transfer your video to 
the Web. This may take a few moments.  

8. Do any of the following:  
1. To play the movie on the Web, click the Watch my movie 

on the Web after I click Finish check box.  
2. To save a local copy of the movie on your computer and 

upload a copy to the video hosting provider's server, click 
Save a copy of my movie on my computer.  

Burn a movie to DVD 

Once you have saved your home movie, you can burn it to a DVD, 
using additional software. Use a program like Sonic MyDVD 4.  
Sonic MyDVD 5 is an incredibly easy way to publish on DVD. With 
Sonic MyDVD 5, it's simple and fun to make great-looking DVDs. 
MyDVD 5 is fully compatible with the Windows Media Video files you 
will be creating with Windows Movie Maker 2. 
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Working with Video Filters in Windows Movie Maker 2.1 
Published: August 25, 2004 
In previous releases of Windows Movie Maker, certain video and 

audio filters from other providers caused issues in Microsoft 

Windows Movie Maker. In this new version, these video and audio 

filters are turned off automatically, helping to improve the overall 

stability of Windows Movie Maker. With Windows Movie Maker 2.1, 

you can control how non-Microsoft video and audio filters that are 

installed on your computer are used in Windows Movie Maker. 

Note: When video and audio filters are turned off in Windows Movie 

Maker, they can still be used by other video and audio programs. 

Turning off the video and audio filters only affects how they're used 

(or, in this case, not used) in Windows Movie Maker. 

About Video and Audio Filters 
Video and audio filters are used in Windows Movie Maker when you import, preview, and save 

movies. Other video and audio programs install filters which might be used when you import, 

preview, and save audio and video files that are not in Windows Media format. Some other 

programs that install video and audio filters include digital media player software, DVD player 

software, DVD writing software, video and audio editing programs, and video and audio codec 

installation software packages. 

Not all of the video and audio filters that are installed by other programs are compatible with 

Windows Movie Maker, which causes problems in Windows Movie Maker when you're importing, 

previewing, and saving movies. To solve this issue, Windows Movie Maker 2.1 automatically turns 

off video and audio filters that are known to cause issues in Windows Movie Maker. You also have 

the option of selecting which filters you want to turn on or off in Windows Movie Maker.  

Changing Video Filter Settings in Windows Movie Maker 
The Windows Movie Maker Compatibility  tab provides a list of video and audio filters. The filters 

that have their corresponding check box cleared are turned off. If you encounter problems when 

importing, previewing, or saving movies in Windows Movie Maker, you can try to resolve the issue 

by turning a video filter off by clearing its check box. 

For more information about video and audio filters and to find a list of filters that are not compatible 

with Windows Movie Maker, see the Microsoft Support Web site. 

You can use the following procedures to change filter settings. 

To turn video filters off or on 

1. In Windows Movie Maker, on the Tools menu, click Options, and then click the Compatibility  

tab. 

2. In the list of video filters, do one of the following: 

1. To turn off a filter, clear the check box. 

2. To turn on a filter, select the check box. 
To reset the default list of filters 

1. In Windows Movie Maker, on the Tools menu, click Options, and then click the Compatibility  

tab. 

2. Click Restore All Defaults. 

Get the Latest 

Download Windows Movie 

Maker 2 

Make movies like the pros. 

Check out the cool effects, 

transitions, and more in 

Windows Movie Maker 2.  
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3. When you restore the default settings, the list and settings for the filters are reset to the last 

known good setting. This option lets you go back to the default list if you make changes to the 

list that later cause issues in Windows Movie Maker. 

 


